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What is the Numerical Fill-In Generator? 

The Numerical Fill-In Generator is a puzzle generator that creates Fill-In puzzles with random numbers 
making each puzzle unique and a challenge to solve. 

A Fill-In puzzle is similar to a crossword puzzle. In a crossword puzzle, the placement of the words is 
known, but the solver must come up with the correct word or phrase. In a Fill-In puzzle, the words (in this 
case numbers) are known; the solver must then place the words in their correct locations in the puzzle. Thus, 
Fill-In puzzles are generally faster and easier to work. 

The Numerical Fill-In Generator sports several features.  

1. There are 15 different puzzle templates to choose from (5 small, 7 normal, and 3 large).  
2. The puzzles can be printed for offline solving or giving to friends.  
3. The solution can be shown at any time.  Alternative solutions are left to the user to discover.  
4. The program contains an brief in-line instruction on playing for quick reference.  
5. The puzzles can be solved completely by using the mouse alone with the AutoFill feature.  
6. An Undo feature allows the user to take one step back in solving the puzzle.  
7. The program allows for the current game to be restarted and new games to be created on the same 

puzzle screen.  
8. There are additional difficulty options for those advanced players who want a greater challenge.  
9. The program's color scheme can be customized to the user's preference and monitor display.  
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System Requirements 

  

Can I run the Numerical Fill-In Generator on my computer? 

In order to run the Numerical Fill-In Generator, the specific computer must meet certain requirements. The 
most basic requirement is that it must run a Windows® 95 or newer operating system. This program was 
written in Visual Basic, so it cannot be run on a Macintosh computer. The computer must also have certain 
additional specifications: 

  

Processor Pentium-based PC capable of running Windows® 95 or later
Memory 64MB of RAM highly recommended 

32MB of RAM required (may not show the program's colors correctly)

Hard Drive Space Required 7MB (includes the complete installation setup package and a full install 
of all components)

Screen Resolution The program was designed to be run with an 800x600 screen resolution 
or greater using Small Fonts.  All of the puzzles have been designed 
with this requirement in mind (hence the strange layouts on a couple of 
the puzzles.)  Resolutions of greater depth than 800x600 will find it 
easier to play, but resizing the windows will only result in increasing 
the area of blank space. Running the game with Large Fonts with 
800x600 resolution will prevent the entire grid from being shown on 
the Large Puzzles. If the game does not run adequately with your 
computer's resolution, change the monitor resolution using the Settings 
tab under Display Properties in the Control Panel.
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How to Play 

  

How do I work Fill-In puzzles? 

Using the starting number given in red and checked in the listing, the goal is to complete the puzzle by 
placing all of the numbers from the various lists in the User Grid. If the option of Do Not Show First 
Number is selected from the Main Menu, the starting number will not be shown in red.  The primary way to 
fill the number into the User Grid is to click with the mouse using the AutoFill feature.  Numbers can also 
be entered with the standard keyboard number keys or the numeric keypad (if Num Lock is on.)  The 
program will check the keyboard input and will allow only number keys, arrow keys, Tab, Delete, 
BackSpace, and the F1 function key to be used. 

Erasing a number in the grid is done by either pressing the backspace key or typing another number in the 
same grid square. Only one digit can occupy a grid square at one time. 

 

As for working the puzzles, the puzzle difficulty is based on the puzzle type's size (small, normal, or large), 
on the puzzle type's grid design (H, Shield, Crazy Eights, etc.), and on the random numbers created by the 
program. The Small Puzzle "H" is considered the easiest of the puzzles. The hardest puzzle is left to the 
solver to decide. 

To begin working the puzzle, check the starting number. The starting number will be in the same location 
every time for the particular puzzle template. This location has been chosen to ensure some difficulty while 
keeping the puzzle solvable. 

This puzzle has a starting number of 84. Note that the box corresponding to 84 in the 2 Digits: category is 
checked. It is possible to deselect this box, but that would not be advantageous. Also, when working a 
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puzzle, if the correct digit is typed over a digit given by the starting number, the digit will be red. If an 
incorrect digit is typed over a digit given by the starting number, then the digit will become black, showing 
that the digit is not correct. This is illustrated in the picture below.  

 

Looking at the starting number of 84, the digit 4 begins a 10-digit number. Looking in the 10 Digits: listing, 
the only number that begins with 4 is 4216082151. Since the digit 4 was given by the starting number, it can 
be trusted that the 10-digit number going down is 4216082151. Check the number off in the list.  This 
number is then placed into the program buffer as shown in the menu.  Click on the starting square where 
4216082151 will be placed, which is the 4 from the 84.  The square's background color will change from 
white to blue. 

 

Finish the process by clicking on a square below the square with the 4 to tell the program that the number 
4216082151 shall be filled downwards.  The program will place the number in the corresponding squares. 
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It should be noted that the AutoFill feature can also fill numbers across by selecting a square to the right of 
starting square.  Clicking on a square above (which could not be done in this example) or to the left of the 
starting square or clicking on the starting square a second time will cancel the AutoFill feature.  The number 
will be retained in the program's memory until it is filled in the puzzle or another number's checkbox is 
checked.  For a more detailed account of the AutoFill feature, see the article AutoFill Instructions. 

The digit 8 begins another 10-digit number. Again looking in the 10 Digits: listing shows that there are three 
numbers beginning with 8. Since there is a question about the number to filled in, the number cannot be 
entered into the User Grid.  Checking the digits of the number 4216082151, it can be seen that only the 
number 52 in the 2 Digits: category would fit across in the squares that end with the first 2 in 4216082151.   
Thus it would be checked off in the list and filled in the grid across starting with the square below the 8 in 
the upper-left corner. 
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Iit is now clear that the 10-digit number 8588572138 is the number going down to the left of 4216082151. 

This process of checking the grid and the number lists is repeated until the grid is filled. If the numbers are 
checked off as they are entered into the grid, remaining numbers can be deduced more easily. If a number's 
grid placement cannot be determined immediately, search the grid for other numbers to be filled in. The 
number's grid placement may not be determined until other numbers have been filled in. In some cases only 
one or two digits can be filled in at a time, making the puzzle difficulty that much greater.  When filling in 
one number at a time, the AutoFill feature is still active.  Cancel the AutoFill feature if the square's 
background becomes blue by selecting the same square or a square to its left or above.  It is then possible to 
fill in the squares using the number keys or keypad and the arrow keys. 

When the user grid is filled correctly, the puzzle is complete. Choosing the Show Solution / User Grid from 
the Edit menu will show the puzzle solution to check one's work. If the two grids are identical, then the 
puzzle has been solved. Depending on the numbers selected there may be a second solution in rare cases. 
These are not shown by the program, and it is up to the solver to give the alternate solution if available. 

  

  
The completed puzzle's User Grid The solution to the puzzle 
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Starting a New Puzzle 

  

How do I start a new Fill-In puzzle? 

 

To select a new Fill-In puzzle type, that must be done from the Main Screen shown above.  The puzzle type 
is the template used for the random numbers the Fill-In puzzle uses.  The puzzle types used in the program 
have been sorted by size.  Click on the New Puzzle menu item, select the size of the puzzle you want to play 
(Small, Normal, or Large), and then select the puzzle grid design (H, Shield, Crazy Eights, etc.)  Below is a 
chart of the puzzle types. 

New games of the SAME puzzle type can be created from the current puzzle form that has been selected.  
Each puzzle type's window has an option called New Game under the File menu.  Selecting this will start 
the puzzle over with a new set of numbers. 

PUZZLE TYPES
SMALL PUZZLE NORMAL PUZZLE LARGE PUZZLE

H Plus Crazy Eights
Five Squares Steps Squares

Pinwheel Shield Four Electrodes
Wheel Broken Pieces

Project X Five Plus
Angled
HTT
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On a similar note, if you wish to restart the current game from the beginning, select the Restart Game option 
from the File menu. 
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Puzzle Differences 

  

What are the main differences between the puzzle sizes? 

The first and most important difference is the grid size. The small puzzle has a 10x10 grid, where as the 
normal puzzle has a 15x15 grid, and the large puzzle has a 20x20 grid. Naturally the larger the puzzle, the 
longer it will take to solve and generally the harder the puzzle. 

The second important difference is the number sorting. In the small and normal size puzzles the numbers are 
sorted by length. Since the large puzzle holds more numbers, the numbers are sorted both by length and by 
orientation. The solver must remain aware that the puzzle solving is somewhat different for the large 
puzzles. This extra sorting is done mostly for convenience and reduction in difficulty. 

A third difference, though not that important, is the color of the form. In order to remind the solver what 
puzzle size is being worked and eliminate some of the monotony between puzzles, large puzzles have a 
purple background, small puzzles have a green background, and the normal puzzles have a blue background. 
These color selections can be customized by the user. 

 
Small Puzzle "Pinwheel" 
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Normal Puzzle "Shield" 
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Large Puzzle "Squares" 
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AutoFill Instructions 

  

How do I use the AutoFill feature? 

The AutoFill feature is a simpler way to enter the numbers into the puzzle grid by simply clicking with the 
mouse.  Once a number has been entered into the program's AutoFill buffer, only two mouse-clicks are 
required to fill the number in.  

l Step 1: Select a number from the list to fill the AutoFill buffer 
Simply click on one of the puzzle's checkboxes to place that number into the AutoFill buffer.  
Clicking on the checkbox will toggle its checked status, but will fill the AutoFill buffer when it 
becomes checked or unchecked.  It is to your advantage to have those numbers checked off when you 
place them in the puzzle.  

l Step 2: Select the square where the number begins 
This is critical.  Select the square where the first digit of the number in the AutoFill buffer will be 
entered into the User Grid.  If you select the wrong square, simply click on the square again to 
deselect it.  The square is selected when its background color changes to blue.  

l Step 3: Select the direction the number is to be placed 
Select a square in the direction that you want to fill the number.  The square must be one of the 
squares that the number will occupy when filled in.  

The AutoFill feature will be aborted IF:  

l There are not enough squares to fill the AutoFill number in the grid in the direction selected.  
l There are any black squares that lie in the area where the number would be filled in.  
l The second square selected lies to the left or above the starting square.  
l Any squares that would be affected by the AutoFill process have a digit in them and the user chooses 

not to overwrite the existing numbers. 

 
Example of the Overwrite Confirmation message given if there is a conflict with the AutoFill process  

l The direction selected is contrary to the direction that the number in the AutoFill buffer is meant to be 
placed (Large Puzzles only). 

 
Example of AutoFill failure due to filling a Large Puzzle number in the wrong direction  
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Although the AutoFill feature is a standard feature and is designed to be the primary way to enter numbers 
into the User Grid, it is possible and sometimes efficient to enter numbers one digit at a time using the 
number keys and the arrow keys.  When this is done, make sure that no square has been selected with the 
AutoFill (i.e. no square has a blue background.) 
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Difficulty Options 

  

How can I increase the difficulty of my Fill-In puzzles? 

Numerical Fill-In Generator Version 2.0 has two different difficulty settings that can be used on all of the 
puzzle types.  These settings can be checked on or off from the Main Menu.  These settings are used during 
the current instance of the program and are reset when the program is started. 

  

l Don't Show First Number 
This option, if checked, will remove the starting number from the puzzle when it is created.  This will 
greatly enhance the difficulty of many puzzles, and since some puzzles are symmetrical, more than 
one solution may exist.  A new menu item, Show Starting Number, will be accessible from the File 
menu on the puzzle to show the starting number if you change your mind for the current game. 
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Small Puzzle Five Squares with the starting number not shown  

   

l Reduced Numbers 
This option increases the difficulty of the puzzles by reducing the value of the digits used in the 
numbers when checked.  Normally the numbers are created with digits ranging from 0 to 9.  When the 
Reduced Numbers option is checked, however, the numbers are created with digits ranging from 0 to 
5.  In turn, this may cause additional duplicates in the smaller numbers (2-digit and 3-digit numbers), 
but the puzzles are solved the same way.  Try the feature on a couple of puzzles to fully understand 
how much more difficult the puzzles become. 

 
Small Puzzle Wheel with the Reduced Numbers option selected  

Both of these options are not set by default.  Nevertheless the puzzles will still be plenty difficult without 
these options.  While every puzzle has a solution, it may not be possible to easily determine the solution. 
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Undo and Show Solution 

  

How do I use the Undo feature? 

The Numerical Fill-In Generator allows the user to go back one step in working the puzzle.  The Undo 
feature utilizes both the AutoFill feature and individual numbers entered into the puzzle.  ONLY THE 
LAST ACTION CAN BE UNDONE.  

l Undo the last AutoFill procdure 
The program remembers the last number that was entered into the User Grid with the AutoFill 
procedure.  If you choose to take back the number you filled in, the grid will be returned to its last 
state leaving behind any numbers that were there.   Additionally the checkbox for that number will 
become unchecked. In this example, the number 0181595839 would be removed and its checkbox 
would be unchecked if the Undo feature was clicked. 

  

   

l Undo a single number 
The program will remember the last number entered into the puzzle grid using the number keys.  If 
you wish to take back this action, the program will state the number entered and the grid location in 
which it was entered in row and column values.  The row number starts with 1 and increases going 
down.  The column number starts with 1 and increases going right.  The maximum row and column 
number is limited to the puzzle size (10 for small puzzles, 15 for normal puzzles, and 20 for large 
puzzles.)   In this example, the 8 that begins 89 would be removed if the Undo feature was clicked. 
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How do I know if my solution is correct? 

The Numerical Fill-In Generator allows you to see the solution to the puzzle as it was created whenever you 
wish.  Under the Edit menu is the option Show Solution / User Grid.  Selecting this menu item will switch 
between the solution of the puzzle and user's current work on the puzzle.  The grid's title will tell you which 
mode you are in currently.  Additionally, the Solution Grid is disabled (grayed out) so you cannot edit the 
solution to the puzzle.  To determine if you have correctly solved the puzzle, check the grids.  Every puzzle 
has a solution.  If your solution differs from the one the program created, but you used all of the numbers 
correctly, then you have found an alternate solution to the puzzle.  The program does not prevent the user 
from making mistakes, but it does help the user to solve the puzzle in his / her own way. 
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Printing a Puzzle 

  

NOTE: A printer that has been installed correctly prior to running the program is required to print the 
puzzles.  If there is no default printer installed, printing could result in a hang up of the program or 
computer. 

  

How do I print out a puzzle? 

The option to print a puzzle was given for three reasons:  

1. For those people who do not wish to work the puzzle on the screen  
2. To share a puzzle with a friend one that the solver has completed  
3. To continue working on a puzzle later  

Regardless of the intention, the print feature only works with the current puzzle and prints the puzzle as it is 
on the screen. Additionally, the printout is in black & white only, therefore use the appropriate ribbon / 
cartridge. 

There are three ways to print.  They are accessible from the Print category under the File menu. 
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l Print Original 
The puzzle screen is printed as the puzzle was given.  If the Starting Number was never shown for 
that game, it will not be in the puzzle.  If you used the option Show Starting Number, the printed 
puzzle will reflect this by adding the starting number as well. The checkboxes are unchecked and the 
grid is cleared.  Useful for giving great puzzles that you have solved to friends.  

l Print Current 
The puzzle screen is printed with the user's current work.  The checkboxes that the user selected are 
printed checked, and the grid retains the numbers that are currently filled in.  Useful for continuing to 
work on a puzzle when you cannot stay at the computer any longer.  

l Print Solution 
The puzzle screen is changed to show the Solution Grid.  The checkboxes are checked and the grid is 
filled.  Great for keeping the solution to check against after finishing a puzzle that you printed.  

The Print Original and Print Current methods will print the User Grid.  The Print Solution method prints 
the Solution Grid.  If the opposite grid is shown before the print method is invoked, the program will switch 
to show the appropriate grid. 

Once you have selected the type of print job that you want, the Print dialog box is shown (see below.) 

Numerical Fill-In Generator 2.0 Help



 

From this menu the selected printer can be modified. You can also select the number of copies that you want 
to print.  The printer's orientation is also changeable by using the Properties button on the printer dialog.  
Puzzles are set to Portrait orientation by default.  If you maximize the puzzles, then it is advised that you 
switch to Landscape for your paper orientation.  All of the puzzles are set to print adequately on an 8.5" by 
11" paper in Portrait orientation if the puzzle has been left at its default size.  If you change your mind about 
printing, canceling this window will cancel the print task. 

After the printout has been sent to the printer, the program will restore the user's current progress of the 
puzzle. 
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Color Preferences 

  

How do I customize the colors of the puzzles? 

Numerical Fill-In Generator Version 2.0 includes the option to change the color scheme for each of the 
puzzle sizes. 

 

The color schemes are separated by puzzle size.  Each puzzle size has four different color values: 

l Background 
This is the color of the puzzle for the selected puzzle size. 

l Primary 
This is the main color of the checkboxes and text for the selected puzzle size. 

l Secondary 
This is the alternate color of the checkboxes for the selected puzzle size.  To make it easier to 
distinguish the length of the numbers at a glance, set this color to a different color than the Primary 
color.  If you prefer to have all of the checkboxes one color similar to the appearance of a printed 
puzzle, then make this color the same as the Primary color. 

l Checked 
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This is the color of a checkbox that has been checked off of the list of numbers to be filled in.  Use 
this color to distinguish between numbers filled into the puzzle grid and those that have yet to be 
filled into the puzzle grid.  If you wish, you can set this color to the Background color so the number 
disappears completely (only for viewing, the checkbox will still be there).  This may get confusing if 
you make a mistake however, so it is not recommended for novice users. 

To change a color, click on the color box that you wish to change.   When you do, the Windows Color 
dialog box will appear. 

 

Select a color and press the OK button to make a change.  Press the Cancel button to back out of the 
procedure.  If you want to select a different color than one that is shown, clicking on the dialog's Define 
Custom Colors >> button will show a larger grid where you can select the specific combination of red, 
green, and blue tints.  You can select that color by selecting a square to place the color (such as the square 
selected in the example picture) and click on the dialog's Add to Custom Colors button. 

The Options menu will allow you to save your current color settings (Save Color Scheme) or reset them to 
the program's default colors (Restore Default Colors). 

If you attempt to exit the Color Preferences screen without saving your changes to the color scheme (if any 
were made), the program will ask you to confirm your desire to exit without saving. 
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Troubleshooting 

  

I cannot see the entire puzzle!  

l Change the monitor resolution. The Numerical Fill-In Generator is designed to be played without 
problems at 1024x768 or 800x600. If the resolution is less than 800x600 resolution, the number lists 
or the grid may not be readable or entirely viewable.  

I tried to maximize / resize the window, but now the menu and header bars are gone!  

l All of the main puzzle functions have keyboard shortcuts. If the puzzle is too large to access the menu 
or header bar with the mouse, pressing Ctrl+R will return you to the Main Menu from any puzzle 
screen. To end the program entirely from any screen, press Ctrl+X.  

l This situation occurs with lower monitor resolution settings. Change the monitor resolution to at least 
800x600 with small fonts or 1024x768 with large fonts.  

I receive an error message saying "Out of memory."  

l This is generally caused when loading the large puzzles. The large puzzles use 20x20 grids. Combine 
the number of checkboxes and labels on the grid, the large puzzle requires a decent chunk of memory. 
If the computer meets the System Requirements, then shut down any unnecessary programs. Check 
the number of shortcuts in the Status bar, in the System tray (where the clock is), and on the Desktop. 
Delete or shutdown any unnecessary programs and shortcuts. If that does not solve the problem, 
consider memory expansion or memory management software such as RamBooster© to more 
effectively manage memory consumption.  

The program asked me to delete my color settings file.  Where is it?  

l This is a rare and unusual case.  The program will ask the user to delete the color settings file only if 
the program had an error in reading back the color settings from the saved file and could not delete 
the file itself.  Generally, this will not happen, but on the off chance that it does, the color settings are 
saved to the NFIGColors.txt file found in the program's installation directory.  Deleting the file may 
not be possible manually.  Check the file's properties to see if it is a Read-Only file.   If so, uncheck 
the Read-Only property and try to delete the file.  If this fails, uninstall the program and reinstall.  
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Contact Information 

  

  

Author: 

Scott Thomson (a.k.a. RPG Man), 
Engineering Programmer, B.S.M.E. 

E-mail: 

rpgman77@yahoo.com 

Web Sites: 

http://www.geocities.com/rpgman77/ 

http://www.freewebs.com/rpgman/ 

© Copyright 2002 
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